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Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

A\ DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

A\ WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

A\ CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property
damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding
potential hazards when working with these products/systems.

Proper use of Siemens products

Trademarks

Note the following:

A\ WARNING

Siemens products may only be used for the applications described in the catalog and in the relevant technical
documentation. If products and components from other manufacturers are used, these must be recommended or
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and
maintenance are required to ensure that the products operate safely and without any problems. The permissible
ambient conditions must be complied with. The information in the relevant documentation must be observed.

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described.
Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this
publication is reviewed regularly and any necessary corrections are included in subsequent editions.

Siemens AG A5E38597895 - AD Copyright © Siemens AG 2019.
Division Digital Factory ® 01/2019 Subject to change All rights reserved
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Introduction

1.1

1.2

Compatibility

Security information

Siemens provides products and solutions with industrial security functions that support the
secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is
necessary to implement — and continuously maintain — a holistic, state-of-the-art industrial
security concept. Siemens' products and solutions constitute one element of such a concept.

Customers are responsible for preventing unauthorized access to their plants, systems,
machines and networks. Such systems, machines and components should only be connected
to an enterprise network or the internet if and to the extent such a connection is necessary and
only when appropriate security measures (e.g. firewalls and/or network segmentation) are in
place.

For additional information on industrial security measures that may be implemented, please
visit (htto://www.siemens.com/industrialsecurity).

Siemens' products and solutions undergo continuous development to make them more secure.
Siemens strongly recommends that product updates are applied as soon as they are available
and that the latest product versions are used. Use of product versions that are no longer
supported, and failure to apply the latest updates may increase customers' exposure to cyber
threats.

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS
Feed under (http://www.siemens.com/industrialsecurity).

General introduction

LOGO! Access Tool is an add-in for Excel. It connects to LOGO! Base Module through HTTP.
LOGO! Access tool provides the following features:

e Set data synchronization period

® Show history data

e Start or stop the data synchronization

® Get value of LOGO! Variables such as |, O and M

® Record all variables values and save them in log files

LOGO! Access Tool supports the following excel versions and LOGO! Base Modules:
e Office Excel 2007, 2010, 2013 (both 32-bit version, and 64-bit version)
e | OGO! 8 Standard, LOGO! 8. FS4 and later version

LOGO! Access Tool Help
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Introduction

1.2 General introduction

Document History

The following editions of LOGO! Access Tool have been published:

Edition Version Comment
07/2016 V1.0.0 First edition
05/2017 V1.01 Second edition
11/2017 V2.0.0 Third edition
03/2019 V2.0.1 Fourth edition

LOGO! Access Tool Help
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Operating the LOGO! Access Tool

2.1 Prerequisite

Note
You can only use LOGO! Access Tool in Local Network with a firewall.

In current version, LOGO! Access Tool only supports one BM connection.

Before using LOGO! Access Tool, make sure that you meet the following requirements:

e |nstall LOGO! Access Tool in Microsoft Excel.

® Connect your PC to the target LOGO! Base Module.

® Enable the Web server access through LOGO!Soft Comfort. On how to enable the Web

server access, referto LOGO!/Soft Comfort Online Help.

2.2 Install LOGO! Access Tool
Before starting working with LOGO! Access Tool, you need to install it first.

1. Copy LOGO!AccessTool.x1lam to your computer.

. LOGO'Access Tool =10l x|
o g =
G\ )v| .+ My Documents + LOGO! Access Tool « |23 [ search LOGO!ACcess Tool w}}‘
Organize *  Indudeinlibrary +  Sharewith = Burn  Mew folder 4= = E;l -ﬁl
‘¢ Favorites Mame = | Date modified | Type | Size |
E | oGO AccessTool xdam 3/25/2016 2:11PM Microsoft Excel Add-In 389 KB
= Libraries
3 Documents
,J'. Music
El Pictures
™ videos

2. Start Excel.
3. On the File menu, point to Options, and then click Add-Ins.

LOGO! Access Tool Help
Operating Instructions, 03/2019, ASE38597895 - AD




Operating the LOGO! Access Tool

2.2 Install LOGO! Access Tool

4. In the Manage box, select Excel Add-ins, and then click Go... button.

Excel Options 2x|
General :.._.. i . i .
: View and manage Microsoft Office Add-ins.
Formulas
Proofing Add-ins
Save MName |Locatior'| |T1rpe |A
L Active Application Add-ins
anguage Team Foundation Add-in “C\.OfficeAdd-in.dIl”  COM Add-in
Advanced SODoCo Ch.ooladyloaderdll  COM Add-in
Send to Bluetooth Chothibtmoffice. dll COM Add-in
Customize Ribbon LogolAccesstool D JAccessToolxlam Excel Add-in b
Eura Currency Tools ChWGEUROTOOLXLAM Excel Add-in
Quick Access Toolbar Acrobat PDFMaker Office COM Addin - C\. MOfficeAddin.dll  COM Add-in
Add-Ins Inactive Application Add-ins
Solver Add-in Ch W ERVSOLVERMLAM  Excel Add-in
Trust Center Mirrosoft &ctinns Pane 3 WM Fynansinn Park_vl
Add-in: Acrobat PDFMaker Office COM Addin
Publisher: Adobe Systems, Incorporated
Compatibility: Mo compatibility information available
Lacation: C\Program Files (x586)\Adobe'\Acrobat 10.04PDFMakerOffice),
PDFMOfficeAddin.dll
Description: Acrobat PDFMaker Office COM Addin
Manage: |[SeSENEH Go...

QK I Cancel

5. In the "Add-Ins available" pane, click Browse... button.

addans 2|

Add-Ins available:

[ Analysis ToolPak ;I oK
[ Analysis ToolPak - VBA

v L Cancel
[ Solver Add-in

Browse...

Automation...

g

-]

rEura Currency Tools

Conversion and formatting for the eura currency

LOGO! Access Tool Help
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Operating the LOGO! Access Tool

2.3 LOGO! Access Tool Menu

6. Browse to the folder which you save "LOGO! Access Tool" in step one and select the tool.

Home Insert Page Layout Formulas Data Review View Add-Ins Acrobat

& Arial 10 A AT = == § General - E_.h Conditional Formatting
- - A =
E3 - ===- $-% » [ErormatasTable-~
Paste = | B o - A - _
¥ B 7 U tirt H- A iEiE | ¥ <0 ;00 (=} Cell Styles ~
Clipboard = Font ] Alignment ¥ Mumber ¥ Styles
A - k|
A 2IxI[F G H I J
1 Add-Ins available:
2 Analysis ToolPak A o |
3 [ Analysis ToolPak - VBA
4 v Ere Currency Tools Cancel |
g ™ solver Add-in
s
7
8 Automation... |
x
e =
QL)@ | .= My Documents = LOGO!Access Tool - @]I Search LOGOAccess Tool Fel
Organize +  MNew folder 3= o+ [l
=l Recent Places LI MName = | Date modified | Type
. L By | 0501 AccessTool xlam 3/25/2016 2:11 PM Microsoft Excel Add-In
= Libraries
@ Documents
J’J Music
Result: LOGO! Access Tool is listed in the "Add-Ins available" pane and its check box is
automatically selected.
7. Click OK.
2.3 LOGO! Access Tool Menu

After installing LOGO! Access Tool successfully, click the toolbar Add-Ins, and then LOGO!
Access Tool menu is displayed as follows.

EE -
Home Insert Page Layout Formulas Data Review WView Add-Ins
LOGO!AccessToal -

Menu Commands

LOGO! Access Tool Help
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Operating the LOGO! Access Tool
2.3 LOGO! Access Tool Menu

LOGO! Access Tool menu consists of two options:
e Start/Stop: you can use it to start or stop data synchronization.

® [ OGO! Access Tool: click itand a drop-down menu appears. This drop-down menu includes
Log In Panel, Configure Panel and About Panel.

2.3.1 Log In Panel
After installing LOGO! Access Tool, log in according to the following steps:
1. Click Log In in the drop-down list of LOGO! Access Tool menu.
]| |

[

1
LOGO!AccessTool =

LogIn
#  Configure

About

2. Enter IP address and password of your LOGO! Base Module after a Login panel pops up,
and then select the check box Run when log in.

Login Panel B
1P Address | 192.168.10.26
Password
[+ Run when log in
Log In |
Note

LOGO! Access tool shares the same access control with Web server. If you have enabled
Web user access without changing the password, you can log in with the default password

"LOGO".

3. Click the Log In button.

LOGO! Access Tool Help
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Operating the LOGO! Access Tool
2.3 LOGO! Access Tool Menu

2.3.2 Configure Panel

In the configure panel, you can set data synchronization period and history data number
according to the following steps:

1. In the drop-down list of LOGO! Access Tool menu, click Configure, and then the configure
panel is displayed.

2. In the scroll bar of Synchronization Period, you can select one number depending on your
need.

Note

The synchronization period can be configured as the following numbers: 1,10, 30, 60
seconds, and the default is 1 second.

Configure Panel il

Synchranization Period 1| -

History Data Number

30
60

E

LOGO! Access Tool Help
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Operating the LOGO! Access Tool
2.3 LOGO! Access Tool Menu

3. In the scroll bar of History Data Number, you can drag the scroll box from up to down to
select one number for the history data.

Note

The history data number varies from 1 to 100, and the default is 5.

Configure Panel il

Synchronization Period

I 10 vl
History Data Number I 5 v|
27

28
29

31
32
33
34 hd

4. After selecting the number for synchronization period and history data number, click
button OK.

Configure Panel il

Synchranization Period 10

History Data Number E

LOGO! Access Tool Help
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Operating the LOGO! Access Tool
2.4 Get LOGO! Variable Value

2.3.3 About Panel

About panel shows the version information of LOGO! Access Tool.

About LOGO! Access Tool x|

B TS "R - GO (R

SIEMIENE] | oo | =0

LOGO! Access Tool 2.0.0

© Siemens AG 2017

2.4 Get LOGO! Variable Value

Note

Make sure that you enable Web server access of the target LOGO! Base Module before using
the LOGO! Access Tool.

After logging in (Page 10) LOGO! Access Tool successfully, you can get LOGO! Variable
values by inputting "=LOGOVAR("id")" in a cell. Then the real time value of this specific variable
is displayed in the cell. The variable value updates according to the data synchronization period

you set in theconfigure panel (Page 11).
Home Insert Page Layout Formulas Data

LOGOAccessToal =

Menu Commands

B1 - S| =LOGOVAR("STATUS")
A B c
1 |BM Status Dffline
2 Outdoor Temperature (Al2) 0
3 Flow Temperature (Al1) 50
4 Switch status (B005) 1
5 Heating on/Off status (Q2) 0
6

LOGO! Access Tool Help
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Operating the LOGO! Access Tool

2.4 Get LOGO! Variable Value

14

"id" means the identification for LOGO! variables. It consists of variable type and valid index.
For one dimensional variables, there is only one index, for example: Q1, Al1, VWO0. LOGO! also
supports multiple dimensional variables which have multiple index, for example: SR1.1.

Note

When you input an invalid or unsupported id for LOGO!, LOGO! Access Tool cannot return
data. The following table shows the variables that can be got with LOGO! Access Tool.

Variable Variable | Valid Index Remarks Example Example
Type
Min Max

BM working sta- | STATUS | N/A N/A Offline
tus Connecting

Stop

Running

Recovering

Invalid Status
Show the Time | TIME N/A N/A The time format is YYYY- | =LOGOVAR("TIME")

MM-DD hh:mm:ss
Flag M 1 64 =LOGOVAR("M1")
Analog flags AM 1 64 =LOGOVAR("AM1")
Digital Outputs | Q 1 20 =LOGOVAR("Q1")
Analog outputs | AQ 1 8 =LOGOVAR("AQ1")
Digital Inputs I 1 24 =LOGOVAR("I1")
Cursor keys Cur 1 4 =LOGOVAR("CUR1")
LOGO! TD F 1 4 =LOGOVAR("F1")
Function keys
Shift register bits | SR 1 4 The first dimension ad- =LOGOVAR("SR1.1")

dresses index of SR

1 8 The second dimension ad- | =LOGOVAR("SR4.8")

dresses index of SR
Network inputs | NI 1 64 =LOGOVAR("NI1")
Analog Inputs Al 1 8 =LOGOVAR("AI1")
Network analog | NAI 1 32 =LOGOVAR("NAI1")
inputs
Network outputs | NQ 1 64 =LOGOVAR("NQ1")
Network analog | NAQ 1 16 =LOGOVAR("NAQ1")
outputs
Variable Memo- | VB 0 850 The first dimension ad- =LOGOVAR("VBO0.0")
ry (In Bit) dresses index of VB
(LOGO! 8.FS4 0 7 The second dimension ad- | =LOGOVAR("VB89.7")
and the later ver- dress index of VB
sion)
Variable Memo- | VB 0 850
ry (In Byte)

LOGO! Access Tool Help
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Operating the LOGO! Access Tool

2.4 Get LOGO! Variable Value

Variable Variable | Valid Index Remarks Example Example
Type
Min Max
Variable Memo- | VW 0 849 The index is counted by =LOGOVAR("VWO0")
ry (In Words) Byte. It will try to reinter-
pret the byte and its next
byte as a big-endian word.
Variable Memo- | VD 0 847 The index is counted by =LOGOVAR("VDQ")
ry (In Double Byte. It will try to reinter-
Words) pret the byte and its next 3
bytes as a big -endian dou-
ble word.
LOGOVAR combinations

You can use the following combinations to set the data format by adding them after the function
LOGOVAR. For example, input "=LOGOVARS("AI")" in a cell, you can get signed value for Al.

Format letter

Description

Data Log letter | Description

S

Show signed value

Show unsigned value

Show binary value

u
B
H

Show hexadecimal value

L Write the value to data log

The default is unsigned val-
ue

The default is that the value is not written
in data log

You can use combination L together with S, H or B. For example, when you input
"=LOGOVARSL("AI1")", you can get a log file with signed value of Al1.

Whether you input L before or after S/H/B, you get the same output for "=LOGOVARSL("AI1")"
and "=LOGOVARLS("AI1")".

Trend direction (TR/TD)

You can add the argument of trend direction after LOGOVAR combination and this argument
is optional. "TR" means that history data is shown on the right of the cell where the formula
"=LOGOVAR("id") is placed. "TD" means the history data is shown on the downside of the cell
where the formula is placed. For example, LOGOVARS( id, "TR") means the signed value and
history data is shown on the right of the cell.

Generate log files with LOGOVARL

To generate log files for a variable, input "=LOGOVARL("id")" in a cell. The log file updates
according to the data synchronization period you set in the lconfigure panel (Page i 1).

® |ogfiles are saved as csv files. The file name is composed of three parts: the excel file
name, IP of the connected BM, and the time stamp. For example,
Test_192.168.0.1_20160406080001.

® | ogfiles are saved in the parent folder of the working excel. If you haven't save the excel yet
or the parent folder cannot be saved, the log files are saved in the My document folder of
the Windows active user.

LOGO! Access Tool Help
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Operating the LOGO! Access Tool

2.4 Get LOGO! Variable Value

16

e [fyou use LOGOVARL for multiple variables, their log files are saved in different columns of
one csv file. See an example of log file as follows .

| A1 - fe| Time
A C

1 [Time la1 VDO

2 9/21/2017 10:15 1 236 236
3 9/21/2017 10:15 1 237 237
4 9/21/2017 10:15 1 238 238
5 9/21/2017 10:15 1 239 239
6 9/21/2017 10:15 1 240 240
7 9/21/2017 10:15 1 241 241
8 9/21/2017 10:15 1 242 242
9 9/21/2017 10:15 1 243 243
10 9/21/2017 10:15 1 244 244
11 9/21/2017 10:15 1 245 245
12 9/21/2017 10:15 1 246 246
13 9/21/2017 10:15 1 247 247
14 9/21/2017 10:15 1 248 248
15 9/21/2017 10:15 1 249 249
16 9/21/2017 10:15 1 250 250
17 9/21/2017 10:15 1 251 251
18 9/21/2017 10:15 1 252 252

® You can add a suffix (@ serial number) to sort your variables in the log files. For example,
if you have five variables in your working excel, you input them as LOGOVARL("Flag1@1"),
LOGOVARL("M@2"), LOGOVARL("Q1@3"), LOGOVARL("SR2.5@4"),
LOGOVARL("F5@5"). Then the variables are listed in your log files as Flag1, 11, Q1, SR2.5,

F5. The default serial number is 0.

Note

Capacity of LOGO! Access Tool

A csv file has a maximum of 20000 lines. LOGO! Access Tool will automatically write to a new
log file when a log file is full.

You can have up to 500 log files in a folder. When the limitation is reached, your old log files will
be removed in chronological order.

LOGAO! 8 Standard can only synchronize 72 variables for all supported types.

LOGO! 8.FS4 and later version can synchronize 75 consecutive VM or 7 discrete VM. LOGO!
8.FS4 and later version has no limit for the other variables.

The variables which cannot be synchronized are returned as invalid data.

LOGO! Access Tool Help
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Operating the LOGO! Access Tool
2.5 Uninstall the LOGO! Access Tool

2.5 Uninstall the LOGO! Access Tool
Follow the below steps to remove LOGO! Access Tool completely from your computer.
1. Start Excel.
2. On the File menu, point to Options, and then click Add-Ins.

3. In the Manage box, select Excel Add-ins, and then click Go... button.

Excel Options 2=
General s L . . . .
c View and manage Microsoft Office Add-ins.
Farmulas
Proofing Add-ins
Save Name | Location | Type |«
Active Application Add-ins
Language Team Foundation Add-in “Ch OfficeAdd-in.dll”  COM Add-in
Advanced SODOCo Chooobhadxloaderdll COM Add-in
Send to Bluetooth Choothibtmoffice.dll COM Add-in
Customize Ribbon LogolAccesstool D AccessToolxlam Excel Add-in e
Euro Currency Tools ChG EUROTOOLXLAM Excel Add-in
Quick Access Toalbar Acrobat PDFMaker Office COM Addin &\ MOfficesddin.dll  COM Add-in
Add-Ins Inactive Application Add-ins
Solver Add-in ChGERVSOLVER XLAM Excel Add-in
Trust Center Mirrnsaft Actinns Pane 3 ¥MI Fxnansinn Parkj
Add-in: Acrobat PDFMaker Office COM Addin
Publisher: Adobe Systems, Incorporated
Compatibility: Mo compatibility information available
Location: ChProgram Files pEg)\Adobe\Acrobat 10.00WPDFMakenOffice’,
PDFMOfficeAddin.dll
Description: Acrobat PDFMaker Office COM Addin
Manage: |[|[E{ENEH 7 Go.. |
K I Cancel
Fl

LOGO! Access Tool Help
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Operating the LOGO! Access Tool
2.5 Uninstall the LOGO! Access Tool

4. In the "Add-Ins available" pane, uncheck the check box next to "LOGO! Accesstool".

addIns 21 x|

Add-Ins available:

Analysis ToolPak ;I
[ Analysis ToolPak - VEA

‘Euro Currency Tools

Logo! Accesstool

Ml Solver Add-in

Cancel
Browse...

Automation...

L3

[

—Solver Add4n

Tool for optimization and equation solving

5. Click OK.
6. On the toolbar Add-Ins, right-click LOGO! Access Tool.
7. Select Delete Custom Command.

™ AR
Haome Insert Page Layout Formulas Data Review

LG OHAccessTool -

Add Group to Quick Access Toolbar

Delete Custom Command

R A T T b LCustomize Quick Access Toolbar...

Show CQuick Access Toolbar BEelow the Ribbon

Customize the Ribbon...

Minimize the Ribbon

8. Delete the source file LOGO! Access Tool from your computer.

LOGO! Access Tool Help
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Reinstall the LOGO! Access Tool

LOGO! Access Tool cannot work properly in the following cases.

® You move LOGO! Access Tool to another location.

® You update excel to a higher version.

® You use excel workbook in another computer.

For the existing workbooks can work properly, follow the below steps to update the tool.

1. Reinstall LOGO! Access Tool. On how to reload your LOGO! Access Tool, refer to Install
LOGOQ! Access Tool (Page 7).

2. Edit the links in your workbook.

Edit the links in your workbook
Update the link to your LOGO! Access Tool according to the following instructions:

1. On the Data tab, in the Connections group, click Edit Links.

Farmulas Data Rey
= _-g] Connections
l
R o
Refresh
All» &= Edit Links

Connections

2. Check the status in the Status column.

Source | Type | Update | Status Update Values |

LOGO!AccessTool.xlam  Worksheet & Error: Source not found
Change Source... |
Gpen Source |
Break Link |
1 | ] Check Status |

Location:
Item:
Update: ¢ Automatic ¢ Manual

Startup Prompt... | Close |

3. Click Change source... and browse to the folder where LOGO! Access Tool stores.

LOGO! Access Tool Help
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Reinstall the LOGO! Access Tool

4. Click the LOGO! Access Tool to update the links. The status of the source changes to "OK".
Source | Type | Update | Status Update Values |
LOGO!AccessTool. xlam  Worksheet A oK
Change Source... |
Open Source
Break Link |
] 2

Location: D:\My Documents\LOGO! Access Tool
Ttem:
Update: % Automatic ¢ Manuzl

Startup Prompt... | Close |

5. Click Close.

LOGO! Access Tool Help
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